U.S. MARINE CORPS:
PERFORMANCE PRICING MODEL

by

Gho Seng Wee

December 2010

Thesis Advisor: Daniel A. Nussbaum
Second Reader: Gregory G. Hildebrandt

Approved for public release; distribution is unlimited
Headquarters, United States Marine Corps Installation and Logistics (I&L), is responsible for executing United States Marine Corps (USMC) logistics policy and management. One of its primary functions is to analyze the suitability and affordability of the annual budgets proposed by the three Marine Force (MARFOR) Commands. A major concern in achieving this is the proper resourcing and budgeting of Secondary Reparables and Consumables in the USMC.

Several databases are used in the USMC’s financial management, logistics, budget-building, and cost-estimation processes. They are the Marine Corps Integrated Maintenance Management System (MIMMS), the Supported Activity Supply System (SASSY), and the Standard Accounting, Budget and Reporting System (SABRS). This thesis combines the data used by MIMMS and SASSY, in conjunction with the updated cost indices from SABRS, to improve fiscal year budget forecasts. The databases were merged and summarized by Table of Authorized Materiel Control Numbers and by MARFORs.

Augmented with appropriate inventory data, this merged database forecasted FY2011 MARFOR budgets using best fit regressions. A key assumption was that the inventory levels were kept constant from the previous fiscal year. The final budget forecasts derived are to be used by I&L in its next Planning, Programming, Budgeting and Execution System (PPBES) meeting.
U.S. MARINE CORPS: PERFORMANCE PRICING MODEL

Gho Seng Wee
Ministry of Defense, Singapore
B.S., Cornell University, 2002

Submitted in partial fulfillment of the requirements for the degree of

MASTER OF SCIENCE IN OPERATIONS RESEARCH

from the

NAVAL POSTGRADUATE SCHOOL
December 2010

Author: Gho Seng Wee

Approved by: Daniel A. Nussbaum
Thesis Advisor

Gregory G. Hildebrandt
Second Reader

Robert F. Dell
Chairman, Department of Operations Research

iii
ABSTRACT

Headquarters, United States Marine Corps Installation and Logistics (I&L), is responsible for executing United States Marine Corps (USMC) logistics policy and management. One of its primary functions is to analyze the suitability and affordability of the annual budgets proposed by the three Marine Force (MARFOR) Commands. A major concern in achieving this is the proper resourcing and budgeting of Secondary Reparables and Consumables in the USMC.

Several databases are used in the USMC’s financial management, logistics, budget-building, and cost-estimation processes. They are the Marine Corps Integrated Maintenance Management System (MIMMS), the Supported Activity Supply System (SASSY), and the Standard Accounting, Budget and Reporting System (SABRS). This thesis combines the data used by MIMMS and SASSY, in conjunction with the updated cost indices from SABRS, to improve fiscal year budget forecasts. The databases were merged and summarized by Table of Authorized Materiel Control Numbers and by MARFORs.

Augmented with appropriate inventory data, this merged database forecasted FY2011 MARFOR budgets using best fit regressions. A key assumption was that the inventory levels were kept constant from the previous fiscal year. The final budget forecasts derived are to be used by I&L in its next Planning, Programming, Budgeting and Execution System (PPBES) meeting.
TABLE OF CONTENTS

I. INTRODUCTION ........................................................................................................1
   A. BACKGROUND ........................................................................................................1
      1. Marine Corps Equipment Readiness Information Tool (MERIT) .........................1
      2. Marine Corps Integrated Maintenance Management System (MIMMS) .................2
      3. Supported Activities Supply System (SASSY) ....................................................2
      4. Standard Accounting, Budgeting, and Reporting System (SABRS) ......................2
   B. LITERATURE REVIEW .......................................................................................2
   C. RESEARCH STEPS ............................................................................................3
   D. THESIS ORGANIZATION AND CONTENT .....................................................4

II. DATA AND METHODOLOGY ...................................................................................5
   A. INFORMATION FLOW .........................................................................................5
      1. USMC Organizational Maintenance ..................................................................5
      2. USMC Organizational Supply ........................................................................6
      3. USMC Supply Management Unit (SMU) ..........................................................6
      4. USMC Intermediate Maintenance Activity (IMA) ............................................7
      5. USMC Repairable Issue Point (RIP) ..................................................................7
   B. DATABASE MERGER .........................................................................................8

III. ANALYSIS OF DATA ............................................................................................11
   A. INTRODUCTION TO LINEAR LEAST SQUARES .............................................11
      1. Objective: Estimating Unknown Parameters ..................................................12
      2. Objective: Checking Model Adequacy .............................................................13
         a. R^2 Values (Coefficient of Determination) ...............................................13
         b. p-Values and t-Statistics .............................................................................13
   B. EXCEL SPREADSHEET SETUP ......................................................................14
      1. Key Functions Used .........................................................................................14
      2. Regressions Models .......................................................................................14
   C. INITIAL ANALYSIS .........................................................................................17
   D. SECOND ANALYSIS .........................................................................................19
   E. ANALYSIS OF “BAD” REGRESSIONS ...........................................................21
      1. TAMCNs With a Significant Contribution to “BAD” Regressions ......................21
      2. TAMCNs With a Nonsignificant Contribution to “BAD” Regressions ...............23
   F. PREDICTING 2011 OVERALL BUDGETS ......................................................25
   G. CONSOLIDATED PREDICTIONS .....................................................................26

IV. CONCLUSION ........................................................................................................29
   A. SUMMARY OF METHODOLOGY .....................................................................29
   B. KEY RESULTS ..................................................................................................30
# LIST OF FIGURES

| Figure 1. | Broad overview of database aggregation | 9 |
| Figure 2. | Output of LINEST function | 13 |
| Figure 3. | Algorithm for determining the label of a regression | 17 |
| Figure 4. | Chart of regression results over RACs | 20 |
| Figure 5. | Algorithm for analyzing “BAD” regressions | 21 |
| Figure 6. | Chart of actual vs. fitted values for TAMCNs with nonsignificant contributions to the “BAD” regressions for 2011 (FY 2010 $ million) | 24 |
| Figure 7. | Growth of actual cost expended over all the RACs | 25 |
| Figure 8. | Query to remove duplicate data in EroHist | 40 |
| Figure 9. | Query to update date and year in Repairparts10 | 43 |
| Figure 10. | Query to remove duplicate data in M67446 | 46 |
| Figure 11. | Relationship view of the databases | 48 |
THIS PAGE INTENTIONALLY LEFT BLANK
LIST OF EQUATIONS

Equation 1. Multiple linear regression model .....................................................................11
Equation 2. Exponential regression model ..........................................................................12
Equation 3. Regression models used ...................................................................................15
Equation 4. Relationship of costs in a log-linear model (Model D)....................................16
Equation 5. Relationship of costs in an exponential model (Model F) ...............................16
Equation 6. Linear Regression Model to describe TAMCNs with a nonsignificant contribution to the “BAD” regressions .................................................................23
THIS PAGE INTENTIONALLY LEFT BLANK
LIST OF TABLES

Table 1. Initial set of TAMCNs .................................................................18
Table 2. Regression results across RACs..................................................19
Table 3. TAMCNs with a significant contribution to the “BAD” regressions ........22
Table 4. Contributing cost of TAMCNs with a nonsignificant contribution to the “BAD” regressions ...............................................................23
Table 5. Predicted cost of TAMCNs that can be aggregated and regressed for 2011 ...24
Table 6. Predicted costs for overall 2011 budget (FY 2010 $ million) ................25
Table 7. Predicted costs (by RAC) for 2011 budget (FY 2010 $ million) ...............27
Table 8. Consolidated predicted costs for 2011 budget (FY 2010 $ mil) ...............30
<table>
<thead>
<tr>
<th>Acronym</th>
<th>Full Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERO</td>
<td>Equipment Repair Order</td>
</tr>
<tr>
<td>EROSL</td>
<td>Equipment Repair Order Shopping List</td>
</tr>
<tr>
<td>FY</td>
<td>Fiscal Year</td>
</tr>
<tr>
<td>HQMC</td>
<td>Headquarters, United States Marine Corps</td>
</tr>
<tr>
<td>I&amp;L</td>
<td>Installation and Logistics</td>
</tr>
<tr>
<td>IMA</td>
<td>Intermediate Maintenance Activity</td>
</tr>
<tr>
<td>MARFOR</td>
<td>Marine Force</td>
</tr>
<tr>
<td>MARFORCOM</td>
<td>Marine Forces Command</td>
</tr>
<tr>
<td>MARFORPAC</td>
<td>Marine Forces Pacific</td>
</tr>
<tr>
<td>MARFORRES</td>
<td>Marine Forces Reserve</td>
</tr>
<tr>
<td>MCBUL</td>
<td>Marine Corps Bulletin</td>
</tr>
<tr>
<td>MERIT</td>
<td>Marine Corps Equipment Readiness Information Tool</td>
</tr>
<tr>
<td>MIMMS</td>
<td>Marine Corps Integrated Maintenance Management System</td>
</tr>
<tr>
<td>NCCA</td>
<td>Naval Center for Cost Analysis</td>
</tr>
<tr>
<td>NSN</td>
<td>National Stock Number</td>
</tr>
<tr>
<td>O&amp;I</td>
<td>Organizational and Intermediate</td>
</tr>
<tr>
<td>O&amp;M</td>
<td>Operations and Maintenance</td>
</tr>
<tr>
<td>Acronym</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>O&amp;S</td>
<td>Operating and Support</td>
</tr>
<tr>
<td>OLS</td>
<td>Ordinary Least Squares</td>
</tr>
<tr>
<td>OPTEMPO</td>
<td>Operating Tempo</td>
</tr>
<tr>
<td>SABRS</td>
<td>Standard Accounting, Budget and Reporting System</td>
</tr>
<tr>
<td>SASSY</td>
<td>Supported Activities Supply System</td>
</tr>
<tr>
<td>SECREP</td>
<td>Secondary Reparables</td>
</tr>
<tr>
<td>P&amp;R</td>
<td>Programs and Resources</td>
</tr>
<tr>
<td>PEB</td>
<td>Program Evaluation Board</td>
</tr>
<tr>
<td>PPBES</td>
<td>Planning, Programming, Budgeting, and Execution System</td>
</tr>
<tr>
<td>RAC</td>
<td>Regional Activity Center</td>
</tr>
<tr>
<td>RIP</td>
<td>Repairable Issue Point</td>
</tr>
<tr>
<td>SABRS</td>
<td>Standard Accounting, Budgeting, and Reporting System</td>
</tr>
<tr>
<td>SASSY</td>
<td>Supported Activities Supply System</td>
</tr>
<tr>
<td>SDN</td>
<td>Standard Document Number</td>
</tr>
<tr>
<td>SECREP</td>
<td>Secondary Reparable</td>
</tr>
<tr>
<td>SMU</td>
<td>SASSY Management Unit</td>
</tr>
<tr>
<td>TAMCN</td>
<td>Table of Authorized Materiel Control Number</td>
</tr>
<tr>
<td>TSC</td>
<td>Total Support Cost</td>
</tr>
<tr>
<td>USMC</td>
<td>United States Marine Corps</td>
</tr>
</tbody>
</table>
EXECUTIVE SUMMARY

Headquarters, United States Marine Corps Installation and Logistics (I&L), is responsible for executing United States Marine Corps (USMC) logistics policy and management. One of its primary functions is to analyze the suitability and affordability of the annual budgets proposed by the three Marine Force (MARFOR) Commands. A major concern in achieving this is the proper resourcing and budgeting of Secondary Reparables and Consumables in the USMC.

Several databases are used in the USMC’s financial management, logistics, budget-building, and cost-estimation processes. They are the Marine Corps Integrated Maintenance Management System (MIMMS), the Supported Activity Supply System (SASSY) and the Standard Accounting, Budget and Reporting System (SABRS). This thesis combines the data used by MIMMS and SASSY, in conjunction with the updated cost indices from SABRS, to improve fiscal year budget forecasts. The databases were merged and summarized by Table of Authorized Materiel Control Numbers (TAMCNs) and by MARFORs.

The initial step taken was to combine MIMMS and SASSY databases, using Microsoft Access, for homogeneity of the data and ease of analysis. Price indices from the SABRS were then used to update prices in the combined database. This combined database was subsequently exported to Microsoft Excel, where inflation indices from the Fiscal Year Enhanced Inflation Calculator from NCAA (Naval Center for Cost Analysis) were used to update the prices to FY 2010 before analysis.

Second, regression analysis was applied to model the relationship between two independent variables, the fiscal year and the inventory levels, and the dependent variable of cost per year. This was done for each TAMCN and each Regional Activity Center (RAC). Both linear and log-linear regressions were analyzed to determine best fit. TAMCNs in the Marine Corps Bulletin (MCBUL) 3000 were used for the analysis purposes, while the RACs were taken from the 3 largest contributors (MARFORCOM, MARFORPAC and MARFORRES).
Analysis showed that 50% of the total contributing actual costs incurred in FY 2010 could be attributed to TAMCNs with regressions that had $R^2$ values exceeding 60%.

An interesting discovery was that of the remaining regressions with very low $R^2$ values (those below 60%), 33.3% of the total contributing actual costs incurred in FY 2010 could be attributed to nine specific TAMCNs, which were either combat vehicles or radio communication equipment. The remaining 16.7% of the total contributing actual costs were regressed as a group, and a statistically significant regression was found for this group.

Third, Marine Force budgets for FY 2011 were then forecasted using the best fitting regressions. A key assumption in this phase was that the inventory levels were kept constant from the previous fiscal year.
ACKNOWLEDGMENTS

I would like to express my sincere gratitude to my thesis advisor, Professor Dan Nussbaum, my second reader, Professor Greg Hildebrandt, as well as my sponsor, Captain Romero.

Professor Nussbaum was patient and accommodating during the thesis process, and his invaluable input to the thesis helped to make for a more coherent paper. His ability to pick out salient points has aided me tremendously in finding a proper focus for this paper.

Professor Greg Hildebrandt has been instrumental in focusing my thesis, as well as providing numerous inputs to the overall cost estimation process.

Captain Romero has been very supportive in providing key information as well as contacts. He has also taken valuable time from his off-duty hours to hold teleconferences with me to clarify key concepts.

Professor Greg Mislick has helped greatly to polish and refine my thesis, spending a great deal of personal time to help me.

In addition, I thank my lovely wife, Evon, and my child, Devon, for supporting and inspiring me throughout this thesis process.
I. INTRODUCTION

A. BACKGROUND

Headquarters, United States Marine Corps Installation and Logistics (I&L), is responsible for executing United States Marine Corps (USMC) logistics policy and management. One of their primary functions is to analyze the suitability and affordability of the annual budgets proposed by the three Marine Force (MARFOR) Commands. A major concern in achieving this is the proper resourcing and budgeting of Secondary Reparables and Consumables in the USMC.

Several databases are used in the USMC’s financial management, logistics, budget-building, and cost-estimation processes. They are the Marine Corps Integrated Maintenance Management System (MIMMS), the Supported Activity Supply System (SASSY) and the Standard Accounting, Budget and Reporting System (SABRS). However, based on key discussions with Capt Alfredo Romero, Program Manager, I&L, users at I&L have expressed a lack of confidence with the cost budgeting information provided by the TSC module in the Marine Corps Equipment Readiness Information Tool (MERIT) application. MERIT is a web based tool used at I&L to aggregate data from MIMMS and SASSY.

The sponsor contacted the Operations Research Department of the Naval Postgraduate School in Monterey, California, for help in increasing their confidence in the budget forecasts by additionally utilizing SABRS data that has been properly correlated with MIMMS and SASSY.

1. Marine Corps Equipment Readiness Information Tool (MERIT)

MERIT is a web based tool that aggregates data from MIMMS and SASSY and displays the current readiness posture and detailed supply and maintenance information for all USMC readiness reportable TAMCNs (Kelly, 2009).
2. **Marine Corps Integrated Maintenance Management System (MIMMS)**

MIMMS is a maintenance information system that is designed to support commanders and logistics managers at all command levels in the execution of ground equipment maintenance management functions (LPS-4, 1977).

3. **Supported Activities Supply System (SASSY)**

SASSY is the primary retail supply accounting system for the USMC. It provides retail supply accounting functions such as stock replenishment, requirements determination, receipts, inventory, stock control, and asset visibility. It provides asset visibility to MERIT (Kelly, 2009).

4. **Standard Accounting, Budgeting, and Reporting System (SABRS)**

SABRS is the primary accounting system for the USMC. It matches budget formulation data with budget execution information. It allows for the USMC to tie the actual fund obligation and execution back to authorized and budgeted amounts (HQMC, Jan 2010, Section 2.4.1).

**B. LITERATURE REVIEW**

A literature review was conducted prior to commencement of this thesis. This thesis is a follow-on work from two previous NPS theses, one by LCDR Patrick Kelly, USN (2009), and the other a joint thesis by Capt Alfredo Romero, USMC and Capt Dustin B. Elliot, USMC (2009). Their theses dealt with predicting future USMC MARFOR budgets using only the Marine Corps Equipment Readiness Information Tool (MERIT). MERIT neither provides output data by TAMCNs, nor does it incorporate the actual price indices from SABRS. This thesis extends previous work by including the SABRS database, which provides a more accurate cost estimate, and summarizes the results by TAMCNs to allow for better budget forecasting.

A report from John M. Chadwick, Armed Forces Comptroller in 2007 (Chadwick, 2007) describes the effort by the USMC Comptroller to separate expenditures into 36
different macro activities-based costs, using SABRS to provide the actual cost data. This is somewhat similar to this thesis, as this thesis aims to delve deeper into the maintenance costs by segregating the data via TAMCNs (instead of the broad-based macro-level activities), using SABRS to provide actual cost indices. They had faced problems linking the activities-based cost to the SABRS database as the costs were not properly collected in SABRS. They resolved the linkage problem by aggregating other data fields to act a pseudo-pointer to actual activity. This thesis used the Standard Document Number (SDN) to link the SABRS database to the MIMMS and SASSY database.

C. RESEARCH STEPS

The initial step taken in this thesis was to combine the MIMMS and SASSY databases, using Microsoft Access, for homogeneity of the data and ease of analysis. Price indices from the SABRS were then used to update prices in the combined database. This combined database was subsequently exported to Microsoft Excel, where inflation indices from the Fiscal Year Enhanced Inflation Calculator from NCAA (Naval Center for Cost Analysis) were used to update the prices to FY 2010 before analysis.

Second, regression analysis was applied to two independent variables, the fiscal year and the inventory levels, to predict the dependent variable of cost per year. Both linear and log-linear regressions were analyzed to determine best fit. TAMCNs in the Marine Corps Bulletin (MCBUL) 3000 (HQMC, 2009) were used for the analysis purposes, while the Regional Activity Centers (RACs) were taken from the three highest contributors (MARFORCOM, MARFORPAC and MARFORRES).

Analysis showed that 50% of the total contributing actual costs incurred in FY 2010 could be attributed to TAMCNs with regressions that had $R^2$ values exceeding 60%.

An interesting discovery was that of the remaining regressions with very low $R^2$ values (those below 60%), 33.3% of the total costs incurred in FY 2010 could be attributed to nine specific TAMCNs, which were either combat vehicles or radio communication equipment. The remaining 16.7% of the total costs were regressed as a group, and a statistically significant regression was found for this group.
Third, Marine Force budgets for FY 2011 were then forecasted using the best fitting regressions. A key assumption in this phase was that the inventory levels were kept constant from the previous fiscal year.

D. THESIS ORGANIZATION AND CONTENT

Chapter II defines the flow of information between the various agencies within the USMC, detailing the SECREPs and consumables information exchanged as well as the methodology for combining the data from the different databases provided by I&L. These steps were explicitly requested by the sponsor and are useful for readers of this thesis.

Chapter III contains the analysis of the data set obtained using regression analysis, as well as key observations noted.

Chapter IV provides observations and recommendations based on the analysis completed.
II. DATA AND METHODOLOGY

A. INFORMATION FLOW

This chapter documents the flow of electronic and nonelectronic documents between the various agencies within the USMC. It details the information exchanged from the moment a piece of equipment is sent for repair until it has completed repair.

Appendix A provides the following flowcharts:

- USMC Organizational Maintenance A.1
- USMC Organizational Supply A.2
- USMC Supply Management Unit (SMU) A.3
- USMC Intermediate Maintenance Activity (IMA) A.4
- USMC Repairable Issue Point (RIP) A.5

1. USMC Organizational Maintenance

Organizational maintenance consists of first- and second-echelon maintenance for a unit that is usually forward deployed. The flowchart in Appendix A.1 describes the process that occurs when a maintenance event commences at the organizational maintenance level.

a. An Equipment Repair Order (ERO) and Equipment Repair Order Shopping List (EROSL) are generated and keyed into MIMMS.

b. If consumables are required, the request is forwarded to the organizational supply.

c. The organizational supply procures the necessary consumables and send the consumables to the organizational maintenance for installation.

d. If secondary reparables (SECREP), which cannot be repaired at the organizational maintenance, are required, the request, as well as the
damaged SECREP, is forwarded to the IMA. If the SECREP are in-stock at the RIP, the RIP returns a functional SECREP to the organizational maintenance.

2. **USMC Organizational Supply**

Organizational supply provides consumables to the organizational maintenance. The flowchart in Appendix A.2 describes the process that occurs when a request for consumables is received at the organizational supply.

a. Upon receiving an EROSL from the organizational maintenance, the organizational supply checks whether the parts are in-stock.

b. If the parts in-stock, they are issued back to the organizational maintenance. If the parts are not in-stock, a request (made in SASSY) is sent to the SMU.

c. Upon receiving the parts from the SMU, the organizational supply forwards them to organizational maintenance.

3. **USMC Supply Management Unit (SMU)**

SMU is a central depot where consumables are supplied to the organizational supply or IMA. SMU also procures consumables when needed. The flowchart in Appendix A.3 describes the process that occurs when a request for consumables is received at the SMU.

a. Upon receiving a SASSY transaction from the organizational supply or the IMA, the SMU checks whether the parts are in-stock.

b. If the parts are in-stock, they are issued back to the requesting agency. If the parts are not in-stock, a request is made to procure these parts directly from the sources of supply (e.g., external contractors). This procurement information is captured in SABRS.
c. Once the required consumables are successfully procured from the sources of supply, the SMU forwards them to the requesting agency.

4. **USMC Intermediate Maintenance Activity (IMA)**

The IMA repairs SECREP's that cannot be repaired at the organizational maintenance. The flowchart in Appendix A.4 describes the process that occurs when a request from the organizational maintenance for a SECREP repair is received at the IMA.

a. Upon receiving an ERO from the organizational maintenance, IMA checks whether the SECREP can be repaired.

b. If it cannot be repaired, the damaged parts are sent back to the RIP. If it can be repaired, IMA checks whether the parts are in the SMU. If they are not available at the SMU, the parts are ordered thru the SMU.

c. After the completion of the repair, the repaired SECREP is issued back to the organizational maintenance.

5. **USMC Repairable Issue Point (RIP)**

The RIP receives SECREP's that cannot be repaired at the IMA, and either sends them for repair or procures a replacement. It issues functional SECREP's back to the organizational maintenance. The flowchart in Appendix A.5 describes the process that occurs when a damaged part is sent from the IMA.

a. Upon receiving a damaged SECREP from the IMA, the RIP checks whether there is stock on-hand.

b. If there is stock on-hand, it issues a working SECREP back to organizational maintenance. If not, it requests contractor support to repair or replace the damaged SECREP before returning it to organizational maintenance. All transactions are recorded in SABRS.
B. DATABASE MERGER

This section documents the steps taken to import and merge the three databases: MIMMS, SASSY and SABRS.

In sequential order, the steps are:

- Creating a new database
- Importing MIMMS
- Importing SASSY
- Importing SABRS
- Forming Relationships
- Running Queries
- Updating Inflation indices

Appendix B provides the detailed steps for the database merger.

This thesis utilizes Microsoft Access to combine the underlying databases and to update the merged database. Figure 1 describes how this thesis aggregates information from the MIMMS and SASSY databases using Equipment Repair Order (ERO) indices to extract Table of Authorized Materiel Control Number (TAMCN) information from MIMMS and updating SASSY with the TAMCN data. Only the TAMCNs found in the MCBUL 3000 were used. SABRS data that matched the records in SASSY were then used to update the costs in the combined database. The analysis thus utilizes a MIMMS-SASSY combined database as the primary database for further analysis, supplemented by the SABRS cost data.

SDN captured in SABRS that did not appear in SASSY were not processed in this thesis. This was due to the difficulty in attaching a TAMCN number to these records, as the SABRS database did not include TAMCN data.

Finally, an aggregation of cost by TAMCN, RAC and year was taken and exported to Microsoft Excel for further analysis.
Figure 1. Broad overview of database aggregation
III. ANALYSIS OF DATA

The following section describes how the cost data extracted from the MIMMS and SASSY were analyzed. This cost data were combined with inventory data provided by HQMC I&L. Regressions were performed using different models to explore and evaluate the best least squares model to utilize. The analysis of the data was focused on the TAMCNs found in the MCBUL 3000 (USMC, 2009).

Further analysis showed that certain TAMCNs could not be accurately modeled using the current data at hand. For further studies, these TAMCNs would need to be examined in greater detail, possibly adding additional variables like operational tempo (OPTEMPO).

A. INTRODUCTION TO LINEAR LEAST SQUARES

Linear least squares (also known as ordinary least squares (OLS)) was the main regression model used to analyze the data in this thesis and is described below (Montgomery, Peck, & Vinning, 2006, chapters 2 and 3).

Regression Analysis is a common statistical method for estimating unknown variables. A 2 variable linear regression model is displayed in Equation 1.

$$y = \beta_0 + \beta_1 x_1 + \beta_2 x_2 + \varepsilon$$

Equation 1. Multiple linear regression model

In this model, $$y$$ is the response (or dependent) variable (or in our case, commonly the cost expended in a financial year) while $$x_1$$ and $$x_2$$ are the regressors (or independent variables, in our case financial year, inventory or both). The model attempts to minimize the sum of the squares of the vertical distances (not Euclidean distances) from the observed responses to the predicted responses predicted by the model. An exponential model can be modified to a log-linear model, by a transformation, as seen in Equation 2.
\[ y = A x_1^{\beta_1} x_2^{\beta_2} \exp(\varepsilon) \]
\[ \ln(y) = \ln(A) + \beta_1 \ln(x_1) + \beta_2 \ln(x_2) + \varepsilon \]

Equation 2. Exponential regression model

This transformation converts an exponential relationship into a linear relationship, thereby permitting the use of the tools developed for the linear case. Such models have been used by cost estimators and found useful, especially in cases involving “learning” that accompanies repeated tasks (Nussbaum, 2010). It was hoped that the process being investigated in this thesis might display some “learning” characteristics. This implies that the input to the linear regression model must be the logarithm functions of the response variables and the regressors.

1. Objective: Estimating Unknown Parameters

There are several computational methods to determine the unknown parameters \( (\beta_0, \beta_1, \beta_2) \). The method that was utilized in this thesis involves a call to the LINEST (Microsoft, 2010) function in Microsoft Excel. This is an alternative to utilizing the Data Analysis package (commonly installed in most versions of Microsoft Excel) to call the Regression Function.

One advantage of using the LINEST function is the ease of calling the LINEST function multiple times to generate many regressions for further analysis. For example, in researching this thesis, more than 4000 regressions were generated.

The LINEST function is input into a 5 by \( x \) (where \( x \) is the number of regressors, plus 1) array. The format of the output is shown in Figure 2, where:

- Cells A1 to E1 with the entries \( m_n \) are the equivalent of \( \beta_i \),
- Cell F1 with the entries \( b \) is the equivalent of \( \beta_0 \)
2. **Objective: Checking Model Adequacy**

The following parameters were used to check for model adequacy.

*a. $R^2$ Values (Coefficient of Determination)*

The $R^2$ values describe the fit of the overall model. This value can vary from 1 (where the model has a perfect fit) to 0 (where the model has no predictive ability). Usually, a higher $R^2$ value is preferred in a model. However, considering $R^2$ values to determine the goodness of fit is a simplified but convenient method.

In the LINEST output, this refers to cell A3 in Figure 2.

*b. p-Values and t-Statistics*

The $p$-Values and $t$-Statistics describe the contribution of the regressors to the overall model. In other words, they are testing whether any of the coefficients $(\beta_0, \beta_1, \beta_2)$ might be equal to zero. Generally, we want $p$-values smaller than 0.05 and larger t-values in order to reject the null hypotheses that coefficients are zero.

In the LINEST output, $t$-Statistic is calculated by dividing Cell A1 by Cell A2 and the $p$-Statistic is calculated by calling a function “TDIST(A1/A2,B4,2).” This finds the probability that a random variable having a Student $t$-distribution, with the appropriate degrees of freedom, is not within the interval defined by $[-\text{the observed statistic}, +\text{the observed statistic}]$. 
B. EXCEL SPREADSHEET SETUP

This section is intended to help readers of this thesis.

1. **Key Functions Used**

The key functions that were used were LINEST (described in Section A.1), PivotTable and INDIRECT.

INDIRECT provides a method to call certain addresses in other worksheets using a text argument. For example, if the Cell A1 held the string ‘B’ and Cell A2 held the number 5, then INDIRECT(A1&A2) will return the value of the Cell B5. This essentially enables the spreadsheet to setup quickly and efficiently, by using indexes to call to other cells.

PivotTable is another important function that summarizes the spreadsheet data by consolidating them into user-defined sections. For example, given a spreadsheet containing Years, TAMCNs, Regional Activity Center (RAC) and Cost, the PivotTable is quickly able to summarize the cost spent over all the years by RAC.

2. **Regressions Models**

In the analysis, six different models of regressions were developed for each TAMCN–RAC pair. These six regressions were analyzed for their quality using the methodology mentioned in Section A.2. In each model, the dependent variable, inventory levels, represented the possessed quantities, rather than the authorized quantities. The six models, with descriptions, are presented in Equation 3.
Model A: \[ \text{Cost} = \beta_0 + \beta_1(\text{Year}) + e \]

Model B: \[ \text{Cost} = \beta_0 + \beta_1(\text{Inventory}) + e \]

Model C: \[ \frac{\text{Cost}}{\text{Inventory}} = \beta_0 + \beta_1(\text{Year}) + e \]

Model D: \[ \text{Cost} = A(\text{Year})^\beta \]

Model E: \[ \frac{\text{Cost}}{\text{Inventory}} = A(\text{Year})^\beta + e \]

Model F: \[ \frac{\text{Cost}}{\text{Inventory}} = A(\text{Year})^\beta + e \]

Equation 3. Regression models used

Model A depicts a linear relationship between the year and the cost incurred for each TAMCN–RAC pair. This implies that every year, the cost is increasing (or decreasing) by a constant amount. For example, if the factor is determined to be 0.20 million/year, and $1 million was spent in year 2010, the model will predict that in year 2011, $1.20 million will be spent and that $1.40 million will be spent in year 2012.

Model B depicts a linear relationship between the inventory and the cost incurred for each TAMCN–RAC pair. This implies that every item held in inventory entails a certain cost. For example, if the factor is determined to be 0.20 million per equipment, and $1 million was spent in year 2010 for three pieces of equipment, the model will predict that in year 2011 (if the same three pieces of equipment are held), $1.00 million will be spent. The model will also predict that $1.40 million will be spent in year 2012, if two additional pieces of equipment are acquired, causing five pieces of equipment to be held.

Model C depicts a linear relationship between the inventory and year and the cost incurred for each TAMCN–RAC pair. This implies that every year, the cost is changing linearly at a certain constant factor, as well as linearly for every item held in inventory. For example, if the factor is determined to be 0.20 million per equipment and 0.5 million per year, and $1 million was spent in year 2010 for three pieces of equipment, the model
will predict that in year 2011 (if the same three pieces of equipment are held) $1.50 million will be spent. The model will also predict that $2.40 million will be spent in year 2012, if two more pieces of equipment are acquired, causing five pieces of equipment to be held.)

Model D depicts an exponential relationship between the year and the cost incurred for each TAMCN–RAC pair. This implies that costs are changing over time in a specific way, namely that the costs in year n and the costs in year 2n are related as follows:

\[ \text{Cost}_{2n} = (\text{Cost}_n)^{2^k} \]

Equation 4. Relationship of costs in a log-linear model (Model D)

Model E depicts a linear relationship between the year and the average cost per inventory held incurred for each TAMCN–RAC pair. This implies that every year, the cost per item held changes by a fixed amount. For example, if the factor is determined to be 0.20 mil/year, and $1 million was spent in year 2010 for three pieces of equipment (average 0.33 million per equipment), the model will predict that in year 2011 (if the same three pieces of equipment are held), $1.60 million (average of 0.53 million per equipment) will be spent. The model will also predict that $3.60 million (average of 0.73 million per equipment) will be spent in year 2012, if two more pieces of equipment are acquired, causing five pieces of equipment to be held.

Model F depicts an exponential relationship between the year and the average cost per inventory held incurred for each TAMCN–RAC pair. This implies that every year, the cost per item held are changing over time in a specific way, namely that the costs in year n and the costs in year 2n are related as follows:

\[ \text{Cost per inventory}_{\text{year } 2y} = (\text{Cost per inventory}_{\text{year } y})^{2^k} \]

Equation 5. Relationship of costs in an exponential model (Model F)
3. **Regression Adequacy and Classification**

A regression is deemed to be adequate if it satisfies the following constraints:

- At least 3 years of relevant data (2008, 2009 and 2010) data must be available. This is to ensure that the regression is not the trivial task of drawing a line between two points.

- Dependent variables must have a $p$-value of greater than 95%.

If the best adequate regression had a $R^2$ value of at least 80%, the TAMCN–RAC will be flagged as “GOOD.” If the best adequate regression had only a $R^2$ value of 60%, the TAMCN–RAC will be flagged as “OKAY.” However if either the best adequate regression had only a $R^2$ value of less than 60% or none of regressions were determined to be inadequate, the TAMCN–RAC pair will be flagged with a “BAD.”

Summarizing, the algorithm is as follows: If there exists at least one regression that is adequate and has more than 3 years of data, check its $R^2$ value: if it is >80%, label as “GOOD”; if it is >60%, label as “OKAY”; or else label it as “BAD.” This algorithm is summarized in Figure 3.

![Algorithm for determining the label of a regression](image)

**Figure 3.** Algorithm for determining the label of a regression

C. **INITIAL ANALYSIS**

The contribution of each TAMCN to overall cost in Fiscal Year (FY) 2010 was considered. This contribution was sorted from the highest contribution to the lowest.
The initial analysis plan involved developing models for the set of TAMCNs that, in total, constituted 80% of the total cost.

The list of 40 TAMCNs that contributed to 80% of the total cost is summarized in Table 1.

<table>
<thead>
<tr>
<th>TAMCN</th>
<th>Description</th>
<th>TAMCN</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A0067</td>
<td>HIGH FREQUENCY VEHICLE SYSTEM</td>
<td>B0160</td>
<td>ASSAULT BREACHER VEHICLE</td>
</tr>
<tr>
<td>A0069</td>
<td>RADIO SET</td>
<td>B1021</td>
<td>GENERATOR SET, SKID-MTD, 60KW/60HZ, TQG</td>
</tr>
<tr>
<td>A0139</td>
<td>RADIO SET</td>
<td>B2567</td>
<td>TRACTOR, RUBBER TIRE, ARTICULATED STEER, MP (TRAM)</td>
</tr>
<tr>
<td>A0273</td>
<td>RADIO SET</td>
<td>D0003</td>
<td>TRUCK, ARMORED, CARGO, 7 TON W/O WINCH, REDUCIBLE</td>
</tr>
<tr>
<td>A0806</td>
<td>SAT TERMINAL, MULTIBAND, LTWT (LMST) MAXI-HUB</td>
<td>D0198</td>
<td>TRUCK, RTAA, CARGO, 7T, WITHOUT WINCH</td>
</tr>
<tr>
<td>A0807</td>
<td>SAT TERMINAL, MULTIBAND LTWT (LMST) MINI HUB</td>
<td>D0209</td>
<td>POWER UNIT, FRONT, 12 1/2T, 4X4</td>
</tr>
<tr>
<td>A1440</td>
<td>RADAR SET, FIREFINDER</td>
<td>D1158</td>
<td>TRK, UTIL, CARGO/TRP CARR, 1 1/4T, W/EQP, HMMWV</td>
</tr>
<tr>
<td>A1440</td>
<td>RADAR SET, AIR TRAFFIC CONTROL, LTWT</td>
<td>D1159</td>
<td>TRK, UTIL, ARMIT CARR, W/SA, 2 1/4T, HMMWV</td>
</tr>
<tr>
<td>A1503</td>
<td>RADAR SET</td>
<td>D1213</td>
<td>TRUCK, RTAA, WRECKER, 7TON, W/WINCH</td>
</tr>
<tr>
<td>A1955</td>
<td>TERMINAL SET, RADIO</td>
<td>E0665</td>
<td>HOWITZER, MEDIUM, TOWED, 155MM</td>
</tr>
<tr>
<td>A1957</td>
<td>RADIO SET</td>
<td>E0671</td>
<td>HOWITZER, LTWT, TOWED, 155MM</td>
</tr>
<tr>
<td>A2042</td>
<td>RADIO SET, HIGH FREQUENCY, MANPACK</td>
<td>E0796</td>
<td>ASSAULT AMPHIBIOUS VEHICLE, COMMAND</td>
</tr>
<tr>
<td>A2043</td>
<td>RADIO SET, MULTIBAND (URBAN)</td>
<td>E0846</td>
<td>ASSAULT AMPHIBIOUS VEHICLE, PERSONNEL</td>
</tr>
<tr>
<td>A2044</td>
<td>RADIO SET, MULTIBAND (MARITIME)</td>
<td>E0856</td>
<td>ASSAULT AMPHIBIOUS VEHICLE, RECOVERY</td>
</tr>
<tr>
<td>A2068</td>
<td>RADIO SET, MULTIBAND, FALCON II</td>
<td>E0935</td>
<td>LAUNCHER, TUBULAR, F/GM TOW WPN SYSTEM</td>
</tr>
<tr>
<td>A2079</td>
<td>RADIO SET, MANPACK</td>
<td>E0947</td>
<td>LAV, LIGHT ASSAULT, 25MM</td>
</tr>
<tr>
<td>A2152</td>
<td>RADIO SET, EPLRS</td>
<td>E0989</td>
<td>MACHINE GUN, MEDIUM, 7.62MM, GROUND VERSION</td>
</tr>
<tr>
<td>A2179</td>
<td>RADIO TERMINAL SET</td>
<td>E1095</td>
<td>MORTAR, MEDIUM, 81MM, EXTENDED RANGE</td>
</tr>
<tr>
<td>A2525</td>
<td>TACTICAL AIR OPERATIONS MODULE</td>
<td>E1378</td>
<td>RECOVERY VEHICLE, FT, HEAVY, W/EQUIP</td>
</tr>
<tr>
<td>A3232</td>
<td>TACTICAL SATCOM, TRANSPORTABLE (SMART-T)</td>
<td>E1888</td>
<td>TANK, COMBAT, FT, 120MM GUN</td>
</tr>
</tbody>
</table>

Table 1. Initial set of TAMCNs
Examination of this table reveals that vehicles and communications equipment make up most of the set. This is unremarkable by itself, except that the same observation is made later in the chapter, under somewhat different circumstances.

Regressions were performed on the items on this list, and the results were divided into two classes:

1. TAMCNs for which regressions performed well, in the sense previously described
2. All other TAMCNs

Unfortunately, the TAMCNs in the first class constituted only 40% of the entire FY 2010 Cost. In an attempt to develop a higher proportion, the analysis also was done on the remaining TAMCNs that made up the remaining 20% of the cost.

D. SECOND ANALYSIS

The regressions were repeated for the entire set of 230 TAMCNs found in the MCBUL 3000 bulletin, and the overall results are presented in Table 2. Note that MIM001 and MIM003 refer to Marine Force Pacific (MARFORPAC), MIM002 refers to Marine Force Command (MARFORCOM) and MIM004 refers to Marine Force Reserve (MARFORRES). Appendix C contains a link to the full set of regression results.

<table>
<thead>
<tr>
<th>RAC</th>
<th>Description</th>
<th>“GOOD”</th>
<th>“OKAY”</th>
<th>“BAD”</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIM001</td>
<td>Number</td>
<td>60</td>
<td>25</td>
<td>120</td>
<td>205</td>
</tr>
<tr>
<td></td>
<td>Sum of Cost</td>
<td>$605 mil</td>
<td>$149 mil</td>
<td>$1,132 mil</td>
<td>$1,887 mil</td>
</tr>
<tr>
<td>MIM002</td>
<td>Number</td>
<td>46</td>
<td>27</td>
<td>130</td>
<td>203</td>
</tr>
<tr>
<td></td>
<td>Sum of Cost</td>
<td>$427 mil</td>
<td>$160 mil</td>
<td>$509 mil</td>
<td>$1,096 mil</td>
</tr>
<tr>
<td>MIM003</td>
<td>Number</td>
<td>35</td>
<td>37</td>
<td>120</td>
<td>192</td>
</tr>
<tr>
<td></td>
<td>Sum of Cost</td>
<td>$103 mil</td>
<td>$66 mil</td>
<td>$117 mil</td>
<td>$285 mil</td>
</tr>
<tr>
<td>MIM004</td>
<td>Number</td>
<td>34</td>
<td>26</td>
<td>111</td>
<td>171</td>
</tr>
<tr>
<td></td>
<td>Sum of Cost</td>
<td>$112 mil</td>
<td>$65 mil</td>
<td>$42 mil</td>
<td>$219 mil</td>
</tr>
<tr>
<td>Total</td>
<td>Number</td>
<td>175</td>
<td>115</td>
<td>481</td>
<td>771</td>
</tr>
<tr>
<td></td>
<td>Sum of Cost</td>
<td>$1248 mil</td>
<td>$440 mil</td>
<td>$1,800 mil</td>
<td>$3,487 mil</td>
</tr>
</tbody>
</table>

Table 2. Regression results across RACs
For example, in MIM004 (MARFORRES), there were 111 “BAD” regressions, contributing to $42 million of the overall cost in FY 2010.

The “Number” row describes the number of TAMCN–RAC pairs that result in “GOOD,” “OKAY,” or “BAD” regressions. The sum of cost is the sum of actual contribution of the TAMCNs that fall into that category based on the cost incurred in FY 2010.

Figure 4 is a visualization of the data in Table 2. It depicts the FY 2010 cost of the contributing TAMCNs by RAC.

![Figure 4. Chart of regression results over RACs](image)

The general trend can be summarized as follows: About 50% (i.e., \([\$1248 \text{ mil } + \$440 \text{ mil}] / \$3,487 \text{ mil}\)) of the cost in FY 2010 can be predicted with significant accuracy. However, this fraction varies across the RACs. Note: Manual adjustments were made for certain log-linear models that exhibited large exponential growth (>100% increase per year). For each of these TAMCN–RACs pairs, the next best adequate regression was selected. The list of adjustments is attached as Appendix D.
E. ANALYSIS OF “BAD” REGRESSIONS

The “BAD” regressions were sorted into two groups, TAMCNs with a significant contribution and TAMCNS with a nonsignificant contribution. The process is described in Figure 5.

![Diagram of analyzing "BAD" regressions]

Figure 5. Algorithm for analyzing “BAD” regressions

1. TAMCNs With a Significant Contribution to “BAD” Regressions

The “BAD” regressions were analyzed separately. These TAMCN–RAC pairs can be divided, in a similar fashion as in Chapter III Section C, identifying the largest TAMCNs, which together constitute 66.7% of the total cost of the “BAD” regressions in Table 2. In this case, nine TAMCNs contributed to 66.7% of the total cost of “BAD” regressions. The list is summarized in Table 3. “Sufficient Data” means that there was sufficient cost data for the TAMCN–RAC pair, but no satisfactory regression could be obtained.
<table>
<thead>
<tr>
<th>TAMCN</th>
<th>DESCRIPTION</th>
<th>MIM001</th>
<th>MIM002</th>
<th>MIM003</th>
<th>MIM004</th>
</tr>
</thead>
<tbody>
<tr>
<td>E0846</td>
<td>ASSAULT AMPHIBIOUS VEHICLE, PERSONNEL</td>
<td>Sufficient</td>
<td>Sufficient</td>
<td>Sufficient</td>
<td>Sufficient</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>E1888</td>
<td>TANK, COMBAT, FT, 120MM GUN</td>
<td>Sufficient</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E0947</td>
<td>LAV, LIGHT ASSAULT, 25MM</td>
<td>Sufficient</td>
<td>Sufficient</td>
<td>Sufficient</td>
<td>Sufficient</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>D0198</td>
<td>TRUCK, RTAA, CARGO, 7T, WITHOUT WINCH)</td>
<td>Sufficient</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A0097</td>
<td>RADIO SET, DUAL VEHICLE ADAPTER, 50-WATT (DVA)</td>
<td>New Equipment</td>
<td>New Equipment</td>
<td>New Equipment</td>
<td>New Equipment</td>
</tr>
<tr>
<td>A1957</td>
<td>RADIO SET</td>
<td>Sufficient</td>
<td>Sufficient</td>
<td>Sufficient</td>
<td>Sufficient</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>A1955</td>
<td>TERMINAL SET, RADIO</td>
<td>Sufficient</td>
<td>Sufficient</td>
<td>Sufficient</td>
<td>Sufficient</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>A2068</td>
<td>RADIO SET, MULTIBAND, FALCON II</td>
<td>Sufficient</td>
<td>Sufficient</td>
<td>Sufficient</td>
<td>Sufficient</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>A0273</td>
<td>RADIO SET</td>
<td>Sufficient</td>
<td>Sufficient</td>
<td>Sufficient</td>
<td>Sufficient</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
</tbody>
</table>

Table 3. TAMCNs with a significant contribution to the “BAD” regressions

Examination of Table 3 reveals, as before, that vehicles and communication equipment make up this list. None of the regressions models was able to provide satisfactory predictions. It may be that other variables or more detailed and complicated multiple regression models would yield more satisfactory results.

It could be postulated that these equipment items were heavily used in the overseas engagements to which the U.S. Marines Corps were deployed. Unfortunately, the models in this thesis cannot address this issue because they track the inventory only at the “possessed” level. In other words, a piece of equipment that was stored and not used was considered to have incurred a similar cost to a piece of equipment seeing active use.
A form of numerically assigning a value to Operating Tempo (OPTEMPO) might be a way to form new regressions on these TAMCN–RAC pairs.

In our current model, the costs of these “BAD” TAMCNs were estimated by predicting overall budget growth for 2011 (as described in Chapter III Section F) and, subsequently, by subtracting sections that can be predicted (as described in Chapter III, Sections D and E.2).

2. TAMCNs With a Nonsignificant Contribution to “BAD” Regressions

The remaining TAMCNs, which together constitute 33.3% of the total cost of the “BAD” regressions in Table 2, were aggregated and considered for analysis (Table 4).

<table>
<thead>
<tr>
<th>RAC</th>
<th>2005</th>
<th>2006</th>
<th>2007</th>
<th>2008</th>
<th>2009</th>
<th>2010</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIM001</td>
<td>$253 mil</td>
<td>$115 mil</td>
<td>$168 mil</td>
<td>$169 mil</td>
<td>$182 mil</td>
<td>$314 mil</td>
</tr>
<tr>
<td>MIM002</td>
<td>$101 mil</td>
<td>$132 mil</td>
<td>$92 mil</td>
<td>$134 mil</td>
<td>$170 mil</td>
<td>$200 mil</td>
</tr>
<tr>
<td>MIM003</td>
<td>$289 mil</td>
<td>$77 mil</td>
<td>$66 mil</td>
<td>$173 mil</td>
<td>$122 mil</td>
<td>$75 mil</td>
</tr>
<tr>
<td>MIM004</td>
<td>$22 mil</td>
<td>$13 mil</td>
<td>$19 mil</td>
<td>$23 mil</td>
<td>$23 mil</td>
<td>$22 mil</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>$663 mil</strong></td>
<td><strong>$337 mil</strong></td>
<td><strong>$345 mil</strong></td>
<td><strong>$500 mil</strong></td>
<td><strong>$497 mil</strong></td>
<td><strong>$611 mil</strong></td>
</tr>
</tbody>
</table>

Table 4. Contributing cost of TAMCNs with a nonsignificant contribution to the “BAD” regressions

For each RAC, log-linear and linear regressions were performed on this residual list of TAMCNs. The best fit was a simple linear regression model from 2006 to 2010 for each RAC. The regression is described in Equation 6.

\[ \text{Cost}_{n+1} = -140,121M + (70M) \text{Year} \]

Equation 6. Linear Regression Model to describe TAMCNs with a nonsignificant contribution to the “BAD” regressions

The predicted values for 2011 are shown in Table 5.
<table>
<thead>
<tr>
<th>RAC</th>
<th>2010 (Actual)</th>
<th>2011 (Predicted)</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIM001</td>
<td>$314 mil</td>
<td>$313 mil</td>
</tr>
<tr>
<td>MIM002</td>
<td>$200 mil</td>
<td>$210 mil</td>
</tr>
<tr>
<td>MIM003</td>
<td>$ 75 mil</td>
<td>$218 mil</td>
</tr>
<tr>
<td>MIM004</td>
<td>$ 22 mil</td>
<td>$27 mil</td>
</tr>
<tr>
<td>Total</td>
<td>$611 mil</td>
<td>$668 mil</td>
</tr>
</tbody>
</table>

Table 5. Predicted cost of TAMCNs that can be aggregated and regressed for 2011

Figure 6 shows the consolidated actual cost of the remaining TAMCNs, which together constitute 33.3% of the total cost of the “BAD” regressions, and plots the consolidated predicted values of the simple linear regression. It shows that, for 2011, the model predicts that $668 million will be expended on this group.

Figure 6. Chart of actual vs. fitted values for TAMCNs with nonsignificant contributions to the “BAD” regressions for 2011 (FY 2010 $ million)
F. PREDICTING 2011 OVERALL BUDGETS

In this section, we use fiscal years to predict expenditures. Based on the historical, annual, by RAC expenditures, several regression models were considered for modeling the increase in expenditures, with results shown in Figure 7. The trend is shown in Table 6. The model used was the Log-linear model, starting from 2007.

![Figure 7. Growth of actual cost expended over all the RACs](image)

<table>
<thead>
<tr>
<th>Model</th>
<th>Starting Year</th>
<th>Parameter</th>
<th>$R^2$</th>
<th>2011 Predicted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log-linear</td>
<td>2007</td>
<td>39% increase</td>
<td>99.9%</td>
<td>$4,772</td>
</tr>
<tr>
<td>Log-linear</td>
<td>2006</td>
<td>27% increase</td>
<td>87.0%</td>
<td>$3,980</td>
</tr>
<tr>
<td>Quadratic</td>
<td>2005</td>
<td>N/A</td>
<td>97.4%</td>
<td>$5,285</td>
</tr>
</tbody>
</table>

Table 6. Predicted costs for overall 2011 budget (FY 2010 $ million)
G. CONSOLIDATED PREDICTIONS

Based on the results above, the following predicted values were computed for FY 2011 (Table 7). This assumes that possessed inventory remains constant (as we do not have predicted inventory data for 2011).

Group A describes the TAMCN–RAC pairs that we have developed adequate regressions for (This process was described in Chapter III Section.D). The FY 2011 predicted values were taken by consolidating the predicted values taken from the models.

Group B2 describes the TAMCN–RAC pairs that constitute 33.3% of the total cost of “BAD” regressions (This process was described in Chapter III Section.E.2). The FY 2011 predicted values were taken by using the simple linear regression model developed.

The 2011 Predicted Cost (Grand Total) was computed by using the Log-linear model. This process is described in Chapter III Section F.

Group B1 describes the TAMCN–RAC pairs that constitute 66.7% of the total cost of “BAD” regressions (This process is described in Chapter III Section.E.1). The FY 2011 predicted values were computed by subtracting Group A and B2 from the 2011 Predicted Cost (Grand Total).

Note: All predictions are in FY 2010 $M, and will need to be converted to FY 2011 $M dollars for budgeting.
<table>
<thead>
<tr>
<th>RAC</th>
<th>Cost</th>
<th>Group B1</th>
<th>Group B2</th>
<th>Group A</th>
<th>Grand Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>“BAD”</td>
<td></td>
<td>“GOOD”</td>
<td>“OKAY”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Significant</td>
<td>Not Sig</td>
<td>Total</td>
<td></td>
</tr>
<tr>
<td>MIM001</td>
<td>2010 Actual Cost</td>
<td>$819</td>
<td>$314</td>
<td>$1,133</td>
<td>$606</td>
</tr>
<tr>
<td></td>
<td>2011 Predicted Cost</td>
<td>$1,125</td>
<td>$377</td>
<td>$1,502</td>
<td>$910</td>
</tr>
<tr>
<td>MIM002</td>
<td>2010 Actual Cost</td>
<td>$309</td>
<td>$200</td>
<td>$509</td>
<td>$427</td>
</tr>
<tr>
<td></td>
<td>2011 Predicted Cost</td>
<td>$434</td>
<td>$240</td>
<td>$674</td>
<td>$641</td>
</tr>
<tr>
<td>MIM003</td>
<td>2010 Actual Cost</td>
<td>$42</td>
<td>$75</td>
<td>$117</td>
<td>$103</td>
</tr>
<tr>
<td></td>
<td>2011 Predicted Cost</td>
<td>$70</td>
<td>$90</td>
<td>$161</td>
<td>$154</td>
</tr>
<tr>
<td>MIM004</td>
<td>2010 Actual Cost</td>
<td>$20</td>
<td>$22</td>
<td>$42</td>
<td>$112</td>
</tr>
<tr>
<td></td>
<td>2011 Predicted Cost</td>
<td>$30</td>
<td>$26</td>
<td>$56</td>
<td>$169</td>
</tr>
</tbody>
</table>

Table 7. Predicted costs (by RAC) for 2011 budget (FY 2010 $ million)
IV. CONCLUSION

A. SUMMARY OF METHODOLOGY

The methodology used to compute the predicted costs for 2011 was as follows:

1. For each TAMCN in MCBUL 3000, extract from the combined database, by RAC, the cost per year.

2. For each TAMCN-RAC combination, use regression to model the costs as a function of the independent variables identified in Chapter III Section B.2. Identify those models that can be used, based on $R^2$ and $p$-values.

3. Classify each useable regression as “GOOD” or “OKAY,” and use it to forecast values for 2011. (Group A)

4. For the TAMCN–RAC pairs with “BAD” regressions, identify the significant contributors and place aside for further analysis. The significant contributors contribute to 66.7% of this cost (Group B1). The remaining 33.3% of the cost will be predicted by a single linear regression. (Group B2)

5. Compute the expected budget for each RAC, based on a linear regression.

6. Tabulate all the results. The predicted amount for significant TAMCN–RAC pairs (Group B1) is estimated by subtracting the expected budget for each RAC by

   (a) predicted amount for “OKAY” and “GOOD” regressions (Group A)

and

   (b) predicted amount of nonsignificant results for TAMCN–RAC pairs with bad regressions (Group B2).
B. KEY RESULTS

<table>
<thead>
<tr>
<th>Description</th>
<th>2011 Estimated</th>
<th>2010 Actual</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group A: “GOOD” Regressions (R-sq &gt;80%)</td>
<td>$ 1,874</td>
<td>$ 1,248</td>
</tr>
<tr>
<td>“OKAY” Regressions (R-sq&gt;60%)</td>
<td>$ 505</td>
<td>$ 440</td>
</tr>
<tr>
<td>“BAD” Regressions (Total)</td>
<td>$ 2,393</td>
<td>$ 1,800</td>
</tr>
<tr>
<td>Group B1: Significant TAMCNs (est.)</td>
<td>$ 1,721</td>
<td>$ 1,189</td>
</tr>
<tr>
<td>Group B2: Nonsignificant TAMCNs</td>
<td>$ 684</td>
<td>$ 611</td>
</tr>
<tr>
<td>Final Figure (log-linear 99%)</td>
<td>$ 4,772</td>
<td>$ 3,487</td>
</tr>
</tbody>
</table>

Table 8. Consolidated predicted costs for 2011 budget (FY 2010 $ mil)

C. MAIN CONCERNS

The main concerns lie with the significant number of TAMCN–RAC pairs that cannot be modeled satisfactorily with our current regression models accurately. These TAMCN–RAC pairs appear to be combat equipment seeing a lot of active duty. Further analysis on this set of equipment will be needed, perhaps by incorporating a variable to represent OPTEMPO.

One other discovery was that when the unusable regressions were analyzed, 66.7% of the cost could be attributed to nine specific TAMCNs, which were either combat vehicles or radio communication equipment. These TAMCN–RAC pairs will need to be analyzed separately with additional variables to obtain a more credible regression (Group B1).

Data from the databases, due to legacy issues, were badly formatted. Considerable effort went into reformatting the data so that the necessary data manipulation and aggregation can be performed successfully. The USMC should develop a more consistent formatting structure.
APPENDIX A. ORGANIZATIONAL FLOWCHARTS

A. USMC ORGANIZATIONAL MAINTENANCE POLICY
B. USMC ORGANIZATIONAL SUPPLY POLICY
C. USMC SUPPLY MANAGEMENT UNIT (SMU) POLICY
D. USMC INTERMEDIATE MAINTENANCE ACTIVITY (IMA) POLICY
E. USMC REPAIRABLE ISSUE POINT (RIP) POLICY
APPENDIX B. DETAILED STEPS FOR DATABASE MERGER

A. INTRODUCTION

This appendix details the steps required for the database merger.

B. CREATING A NEW DATABASE

Open Microsoft Access and click on [Create New Database]. Save the Database under a preferred name.

Note: Occasionally when performing the steps listed below, certain out-of-memory issues may occur. If this happens, close all open tables and queries and click File-> Compact Database.

C. IMPORTING MIMMS

The EroHist.txt (dated June 6, 2010) was used in this import step

1. Importing Text File

This process describes the steps needed to perform the text file import.

a. [External Data]->[Import-Text File]

b. Specify location of EroHist.txt in the dialog box. Leave the bullet on the default position “Import the source data into a new table in the current database.” Click [Next]

c. Select the “Delimited–Characters such as comma or tab separate each field” bullet. Click [Next]

d. Select the “Other:[ ]” bullet. Input the vertical bar “|” in the box. Check the box “First Row Contains Field Names”. Click [Advanced]

Note: sometimes Access will not allow you to input the vertical bar. Pressing backspace or delete a few times after selecting the box before inputting “|” might help
e. Under the table in “Field Information:” Check all the boxes except for the following fields:

- EQUIP_REPAIR_ORDER_NUM
- REGIONAL_ACTIVITY_CODE
- DATE_RECEIVED_IN_SHOP
- TAM_CONTROL_NUMBER
- Click [OK]. Click [Finish]

f. Query will then run for about 5 minutes, depending on processor speed

Optional: Check [Save Import Steps]. This will allow you to skip this process 3.2 in future iterations. Click [Save Import].

The text import is completed at this point.

2. Deleting Erroneous Data

This process allows you to remove records that have faulty TAM_CONTROL_NUMBER (or nonexisting).

a. Click on EroHist: Table (It should be on the tab under the toolbox, if not double click on EROHist: Table on the left column)

b. Click on the header “TAM_CONTROL_NUMBER” and select [HOME] > [AZ down arrow]

> [AZ down arrow]

c. This will sort the TAM_CONTROL_NUMBER alphabetically

d. Once the sort is complete. Select the first rows that do not start with an alphabet. Press Delete on your keyboard.

For the current version, 262863 records were deleted

The deletion of erroneous data is completed at this point.
3. **Deleting Duplicate Data**

Deleting duplicate data is required for the relationship query to work later. This section outlines the steps taken to delete the duplicate data.

a. Click [CREATE] -> [QUERY DESIGN]

b. In the “Show Table” Dialog, select EroHist and click [ADD]. Click [CLOSE]

c. Click [DESIGN] -> [Query Type/Make Table]. In the dialog box, input the “EroHist–no duplicates” under Table Name

d. In the table below. Input the following information

- In Field1, Select EQUIP_REPAIR_ORDER_NUM
- In Field2, Select REGIONAL_ACTIVTY_CODE
- In Field3, Select DATE_RECEIVED_IN_SHOP
- In Field4, Select TAM_CONTROL_NUMBER
- In Table, Select EroHist for all 4 fields

e. Click [DESIGN] -> [Show/Hide–Totals]

f. Under the Total for field 4 (TAM_CONTROL_NUMBER), Change it from “Group By” to “First”

g. Click [DESIGN] -> [RUN]

h. Query will run for about 5 min, depending on processor speed

i. An Alert box saying “You are about to paste 1870509 row(s) into a new table”. Click “YES”

*Optional*: Right Click on Query1 Tab just below the toolbar, and select “SAVE”

In the “Save As” Dialog box, save the Query Name as “EroHist-no duplicates query”
From an initial total of 1,905,557 records, the query returned 1,870,509 records. Hence, there were 35,048 additional duplicate entries. This query took all the fields that have the same ERO, RAC and Date and compare the TAMCNs. If the ERO, RAC and Date are the same, the query took the 1st TAMCN (alphabetically sorted).

The deletion of duplicate data is completed at this point.

Figure 8. Query to remove duplicate data in EroHist
D. IMPORTING SASSY

The repairparts10.txt (dated Oct 8th 2010) was used in this import step.

1. Importing Text File

This process describes the steps needed to perform the text file import.

   a. [External Data]->[Import-Text File]

   b. Specify location of repairparts10.txt in the dialog box. Leave the bullet on the default position “Import the source data into a new table in the current database.” Click [Next]

   c. Select the “Delimited–Characters such as comma or tab separate each field” bullet. Click [Next]

   d. Select the “Other:[ ]” bullet. Input the vertical bar “|” in the box. Check the box “First Row Contains Field Names”. Click [Advanced]

      Note: sometimes Access will not allow you to input the vertical bar. Pressing backspace or delete a few times after selecting the box before inputting “|” might help

   e. Under the table in “Field Information:” Check all the boxes except for the following fields:

      - EQUIP_REPAIR_ORDER
      - REGIONAL_ACTIVITY_CODE
      - LDRDBA_LDR_MIMMS_REPAIR_PARTSDATE_RECEIVED_IN_SHOP
      - DOCUMENT_NUMBER
      - QUANTITY_RQUIRED
      - PARTS_CHARGE
      - NATIONAL_STOCK_NUMBER_REQUIRED (Change Data Type to Text)
• LEGACY_FILE_DTTM (Change Data Type to Text)

f. In additional for fields (vii) and (viii), change the “Data Type” to “Text”. This will prevent Access from throwing errors later.

g. Click [OK]. Click [Finish]

h. Query will then run for about 1 min, depending on processor speed

Optional: Check [Save Import Steps]. This will allow you to skip this process 3.2 in future iterations. Click [Save Import].

The text import is completed at this point.

2. **Updating the LEGACY_FILE_DTTM and DOCUMENT_NUMBER**

This process modifies the LEGACY_FILE_DTTM by throwing out the date and month, and keeping only the year. It also pre-pends the letter “M” to standardize the DOCUMENT_NUMBER to the SABRS database.

a. Click [CREATE]->[QUERY DESIGN]

b. In the “Show Table” Dialog, select Repairparts10 and click [ADD]. Click [CLOSE]

c. Click [DESIGN]->[Query Type/UPDATE]

d. In the table below, input the following information

e. Under Field1, Select LEGACY_FILE_DTTM

f. In Table, select repairparts10

g. In “Update to”, input the following information “RIGHT([LEGACY_FILE_DTTM],4)”

This will utilize only the last 4 numbers of the LEGACY_FILE_DTTM field

h. Under Field2, Select DOCUMENT_NUMBER

i. In Table, select repairparts10

j. In “Update to”, input the following information “M”&[DOCUMENT_NUMBER]

k. Click [DESIGN]--->[RUN]

l. Query will run for about 1 min, depending on processor speed

An Alert box saying “You are about to update 677002 row(s)”. Click “YES”

[OPTIONAL] Right Click on Query1 Tab just below the toolbar, and select “SAVE”

In the “Save As” Dialog box, save the Query Name as “Repairparts10-update year & sdn”

The data change is completed at this point.

Figure 9. Query to update date and year in Repairparts10
3. Deleting Erroneous Data

This process allows you to remove records that have faulty ERO number.

a. Click on Repairparts10: Table (It should be on the tab under the toolbox, if not double click on Repairparts10: Table on the left column)

b. Click on the header “EQUIP_REPAIR_ORDER” and select [HOME]->[AZ down arrow]

This will sort the EQUIP_REPAIR_ORDER alphabetically

c. Once the sort is complete. Select the first rows that do not start with an alphabet. Press Delete on your keyboard.

For the current version, 7856 records were deleted

The deletion of erroneous data is completed at this point.

E. IMPORTING SABRS

This section will document the steps taken to import the SABRS file. The file 2ND_MLG (15th Oct 2010) was used in this section.

1. Copying the File to the Main Database

This process copies the table over to the main Database so that it can be worked on.

a. Open the second _MLG.db file

b. Right click on M7446: Table on the left column and right click “Cut”

c. Go back to your original database (There should be a separate window for it)

d. Right Click on the left column and select “Paste”

e. The process will take about 5 minutes to import

The file copy is completed at this point.
2. **Deleting Duplicate Data**

Deleting duplicate data is required for the relationship query to work later. This section outlines the steps taken to delete the duplicate data.

a. Click [CREATE]->[QUERY DESIGN]

b. In the “Show Table” Dialog, select M67446 and click [ADD]. Click [CLOSE]

c. Click [DESIGN]-> [Query Type/Make Table]

d. In the dialog box, input the “M67446–no duplicates” under Table Name

e. In the table below. Input the following information

   - In Field1, Select Tot Trans Amt
   - In Field2, Select Std Doc No
   - In Table, Select M67446 for all 4 fields

f. Click [DESIGN]->[Show/Hide–Totals]

g. Under the Total for field 1 (Tot Trans Amt), Change it from “Group By” to “Sum”

h. Click [DESIGN]->[RUN]

i. Query will run for about 15 min, depending on processor speed

   An Alert box saying “You are about to paste 10686011 row(s) into a new table”. Click “YES”

   **Optional**: Right Click on Query1 Tab just below the toolbar, and select “SAVE”

   In the “Save As” Dialog box, save the Query Name as “M67446-no duplicates query”

The deletion of duplicate data is completed at this point.
F. FORMING RELATIONSHIPS

This section details how to link up the databases with the right relationships

a. Click [Database Tools]-->[Show/Hide–Relationships]
   - In the “Show Table” window
   - Select EroHist-no duplicates, click [ADD]
   - Select M67446-no duplicates, click [ADD]
   - Select Repairparts10, click [ADD]
   - Click [CLOSE]

b. Click [Design]-->[Edit Relationships]
   - MIMMS-SASSY Relationships
     - In the “Edit Relationships” window, click “Create New”
     - In the Left Table Name, select “EroHist–no duplicates”
In the Left Column Name, select “EQUIP_REPAIR_ORDER_NUM”

In the Right Table Name, select “Repairparts10”

In the Right Column Name, select “EQUIP_REPAIR_ORDER_NUM”

Click OK

Add REGIONAL_ACTIVITY_CODE under the left table under “EQUIP_REPAIR_ORDER_NUM”

Add REGIONAL_ACTIVITY_CODE under the right table under “EQUIP_REPAIR_ORDER_NUM”

Add DATE_RECEIVED_IN_SHOP under the left table under “REGIONAL_ACTIVITY_CODE”

Add LDRDBA_LDR_MIMMS_REPAIR_PARTS_DATE_RECEIVED_IN_SHOP under the right table under “REGIONAL_ACTIVITY_CODE”

Click [Create]

SASSY-SABRS Relationships

In the “Edit Relationships” window, click “Create New”

In the Left Table Name, select “Repairparts10”

In the Left Column Name, select “DOCUMENT_NUMBER”

In the Right Table Name, select “M67446-no duplicates”

In the Right Column Name, select “Std Doc No”

Click OK

Click [Create]
The relationships are formed at this point.

Figure 11. Relationship view of the databases

G. UPDATING COST INDICES

The FY 11 Enhance Inflation Calculator\(^1\) from NCCA (Naval Center for Cost Analysis) was used to update all costs to FY 10. All costs listed in the thesis hereafter are listed as FY 2010$.

\(^1\) http://www.ncca.navy.mil/services/inflation.cfm
APPENDIX C. DETAILED REGRESSION RESULTS

A. INTRODUCTION

This appendix provides the detailed regression results in the attached Excel spreadsheet, which may be accessed by clicking here.

B. TABS

The following tabs describe the information inside the Excel spreadsheet

Data
1. Inventory: Possessed inventory data from 2000 to 2009. Cells H:AK describes the PivotTable of Possessed Inventory Data, by RAC. Cells AM:AT describe the PivotTable of Possessed Inventory Data, consolidated across all RAC.
2. MCBUL 3000: List of TAMCN in the MCBUL 3000.
3. TAMCN: References the TAMCN to a description

Cost Data
4. From Access: Data from access. Formatted by RAC, Year, TAMCN, MCBUL 3000 (To extract out only MCBUL 3000 TAMCNS), Cost, FY 2010 (Cost adjusted to FY 2010 figures)

Analysis
5. Pivot: Pivot Table from “From Access” tab. Columns K onwards decomposes the spreadsheet data from the “From Access” tab to rows and includes the inventory data. Column V:AA are placeholders to describe the cost per inventory. Columns AC:AF describes which year to start (due to lack of data, or whether the equipment is new)
6. Regression: 770 TAMCNS X 6 Models = 4620 individual regressions done
8. Bad TAMCNS: Cells H11 to H19 describes the list of TAMCNS with “BAD” regressions, extracted out from “Regressions” Tab
9. Overall Summary: Overall Performance data, aggregated. Cells A3 to H12 are used in this thesis.
APPENDIX D. LISTING OF TAMCN-RACS MANUALLY DELETED FOR LOG-LINEAR MODELS

<table>
<thead>
<tr>
<th>Number</th>
<th>RAC</th>
<th>TAMCN</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>MIM001</td>
<td>A0882</td>
</tr>
<tr>
<td>2</td>
<td>MIM001</td>
<td>A2042</td>
</tr>
<tr>
<td>3</td>
<td>MIM001</td>
<td>A2068</td>
</tr>
<tr>
<td>4</td>
<td>MIM001</td>
<td>D0031</td>
</tr>
<tr>
<td>5</td>
<td>MIM002</td>
<td>A0069</td>
</tr>
<tr>
<td>6</td>
<td>MIM002</td>
<td>A0124</td>
</tr>
<tr>
<td>7</td>
<td>MIM002</td>
<td>A0273</td>
</tr>
<tr>
<td>8</td>
<td>MIM002</td>
<td>A0807</td>
</tr>
<tr>
<td>9</td>
<td>MIM002</td>
<td>A2068</td>
</tr>
<tr>
<td>10</td>
<td>MIM002</td>
<td>B0392</td>
</tr>
<tr>
<td>11</td>
<td>MIM002</td>
<td>E0055</td>
</tr>
</tbody>
</table>
LIST OF REFERENCES


INITIAL DISTRIBUTION LIST

1. Defense Technical Information Center  
   Ft. Belvoir, Virginia

2. Dudley Knox Library  
   Naval Postgraduate School  
   Monterey, California

3. Daniel A. Nussbaum, PhD  
   Naval Postgraduate School  
   Monterey, California

4. Gregory G. Hildebrandt  
   Naval Postgraduate School  
   Monterey, California

5. Col (Ret) Edward Lesnowicz  
   Naval Postgraduate School  
   Monterey, California

6. Maj David Vaughan  
   HQMC, I&L Branch  
   Washington, DC

7. Prof. Yeo Tat Soon  
   Temasek Defence Science Institute  
   Singapore

8. Ms. Tan Lai Poh  
   Temasek Defence Science Institute  
   Singapore